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Chapter 1. Introduction

The purpose of this guide is to present the Administrator & Developer
workbench, the graphical interface of VisualAge Pacbase since its 3.0 version.

You will discover another VisualAge Pacbase as its user interface has been
entirely redesigned for ease of use.

For those of you who are familiar with the VisualAge Pacbase WorkStation or
the character-mode VA Pac screens, this new environment will certainly
change the way you used to work with VisualAge Pacbase.

If you are new to VisualAge Pacbase, we recommend you first read the
[VisualAge Pacbase Metamodel and Repository’| manual where fundamental
concepts are developed.

This guide is intended to provide an exhaustive documentation of the
workbench but to present its structure in modules, its principles of graphic
architecture and navigation, and to guide you through its generic use.

Moreover, if you are an Administrator, we strongly advise you to read the
following two chapters:

e ’'Prior administration actions’

This chapter presents the operations to be performed step by step in
Administrator workbench, in order to have a first installation of VisualAge
Pacbase that will reliably operate.

* ’Other administration operations’

The detailed documentation of Administrator & Developer workbench is
available in online help. This is why you will systematically find in this guide
references to the online help.

NOTE: In this guide, "Administrator & Developer workbench’ will often be
shortened to "AD workbench’. The "Workbench’ term will also be
used to name an AD workbench module.

Workbench Client/Server processing

Administrator & Developer workbench is the new workstation of VisualAge
Pacbase. It constitutes the client part of VisualAge Pacbase and uses advanced
techniques for the communication with both a Development Database and the
Administration Database.

© Copyright IBM Corp. 1983,2004 1
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A site consists of an Administration Database and one or several Development
Databases.

All the specifications entered in a Development Database are saved and stored
in the Repository.

The Administration Database contains all data related to your site
administration.

Whether you are administrator or developer, you will work in client/server
mode.

NOTE: Every time your workbench communicates with a VA Pac Database,

the following icon appears: % .

Data access, therefore, implies the import of instances into the local workspace
of your workbench. A workspace is defined in relation to a module, a
Database, a user code, and a session.

NOTE: Some entities dedicated to the administration domain are
automatically imported.

Any update (modification) must be saved, in a reasonable time frame, in the
Repository. Your workspace is used for your current daily work only.

WARNING: The deletions of instances are immediately saved in the
repository (after confirmation).

The import of an instance does not lock the instance, another user can import
it into his/her workspace and possibly change it.

NOTE: An explicit lock of instance is however possible (cf. ‘Instances lock’
chapter).

When you save an instance in the VA Pac Repository, a warning informs you
if other updates have been saved for this instance since it has been imported
into your workspace. In that case, you can:

* Temporarily keep your updates in your workspace, without saving them in
the Repository, and contact the author of the possibly conflicting updates.
This author is identified by his/her User code in the warning.

* Save your updates which may override those saved in the meantime by
another user.

* Cancel your updates and recover the current server version of the instance.

2 VisualAge Pacbase: Administrator & Developer workbench User’s Guide



The important notions of workspace and import are developed in Chapter 5:
"Workspace, instances import, Off line mode’.

Administrator & Developer workbench modules

Administrator & Developer workbench is not a monolithic tool, it is

subdivided into several modules, each including a consistent set of functions.

e Administrator workbench

Administrator workbench is the tool dedicated to VisualAge Pacbase
Administrators.

You can initialize and manage the following elements, via entity
browsers. Most of these browsers are exclusively reserved for
Administrators:

- Access Keys and Licenses,

- Development Database(s),

- Libraries,

- Profiles,

- Users,

- PacTransfer parameters,

- Administration Documents,

- Optional Command Lines Set (OCLS).

These characteristics concern data stored in the Administration Database

(except Libraries, specific to a Database) and they are accessible via the
Administrator workbench only.

Three specific tools give access to the management of the following
elements:

- Security,
- Parameters,
- Sessions.

Another set of characteristics can be managed in Administrator
workbench. They are specific to a Development Database and therefore
are stored in this Database:

- Meta Entities, User Relations, and User Entities.
Also available in: Global workbench

Input Aids

Also available in: Global workbench

Configuration Environments (SCM)

Also available in: eBusiness, Dialogue, Batch modules and Global
workbench

- Documents

Chapter 1. Introduction
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Available in all modules (except CFM).

A connection to Administrator workbench in ‘Database” mode is required to
have access to the Library browser and to this last set of functions. For
more information on the connection to AD workbench, refer to the next
chapter.

Chapters 3 and 4 in this guide are dedicated to Administrator workbench.

— Developer workbench
1. eBusiness module

The eBusiness module is dedicated to the development of eBusiness
applications.

The server part to access and process data of an eBusiness application is
entirely managed with the eBusiness module.

But, the client part of these applications is developed in a Java
development tool such as WebSphere Studio and uses Proxies generated
by ‘eBusiness tools’, (included in this module).

For an introduction to eBusiness development with VA Pac, we
recommend to read the manual "eBusiness and Pacbench C/S
Applications: [Concepts and Architectures’|

This module also includes the UML Interface and Services Modeler (see
also point 4.).
2. Dialogue module
The Dialogue module is dedicated to the development of online
applications. You can also develop batch Programs and printed Reports.
3. Batch module
The Batch module is dedicated to the development of batch applications
and printed Reports.
4. Services Modeler module
This module is a modeling tool which enables you to specify Services

and generate the XML-based Description of these services in a WSDL
(Web Services Description Language) file.

5. Global workbench
The Global workbench is dedicated to developers who need to specify a
wide range of different entities, all accessible via only one browser.

With Global workbench, you have a direct access to all the entities of
the VA Pac Repository, except those entities specific to the
Administration domain.

For a complete documentation on the respective functions of all the above-mentioned
modules, refer to the online help.
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¢ CFM (Configuration File Manager)

This utility allows you to inhibit the display of unused browsers and/or to
display browsers specific to Meta Entities, User Relations, User Entities,
defined for a given Database. You can also organize the tabs within the
modules and thus customize your modules.

NOTE: The extended online help function (with Table of Contents) cannot
be customized.

Consult the VisualAge Pacbase Technical Support for further information on
SCM module.

Graphic architecture and browsing

Workbench browser - Entity tabs

Each module of AD workbench opens with a browser divided into tabs. Each
tab corresponds to an entity managed by the module.

From an entity tab, you can:
* Create new instances of the entity,

* Import instances already defined in the VA Pac Repository; either in a
Development Database or in the Administration Database,

¢ Open and edit instances of this entity, already locally created or imported
into your workspace.

An entity tab displays at least two panes:
* the entity list of instances.

From a list, you have access to many functions and/or windows,
documented in the "Lists of instances” chapter.

Chapter 1. Introduction 5
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* a Definition pane which displays information on the instance selected in

the list.
Instance browsers

To open the browser of an instance present in your workspace, click on this
instance in the List pane of the entity tab, select the ‘Open’ choice (popup
menu via mouse right click or ‘Selected” menu), or simply double click on the

instance line.

In general, the browser of an instance contains several tabs where are
displayed the Definition and the different Descriptions associated with the

selected entity.
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The browser of an instance is referred to as first level browser. If you open a
browser from a Description (Data element call for example), you open a
second level browser.

Smartguides

The smartguides are dialog boxes which allow to create and modify data
generated in Administrator & Developer workbench. This data is of all types,
from the instance in general to a description element of the instance.

NOTE: Some descriptions can however be fullpage displayed.
The input via a smartguide is guided as you fill in, for example, fields with

drop-down list of predefined values, or choose options via radio buttons or
check boxes.

EXAMPLE: The smartguide below opens up from the Segment browser, 'SQL
Accesses’ tab. It is used to define an SQL access.
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Online help

The online help of Administrator & Developer workbench is an ordered set of
html pages and so benefits from all the facilities of a navigator.

You can select a navigator different from the one associated with the .htm
extension files. To do so, specify your preference in ‘File’ / 'Preferences’ /
‘General’ / "Help'.

The online help appears in two forms:
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* An extended online help, specific to the open module, with a Table of
Contents and accessible via the "Help” menu, "Help Home Page’ choice.

; Vizualige Pachase Help Online - Microzoft Internet Explorer provided by IBM Paris Laboratory =) ﬁ
File Edit Wew Favoites Tools Help “

iR Back - J E‘ ﬁ @Search ﬂ‘Favontes QMedla Q 3' j g -

Address |@ file: /#/0: AppsVisualboe_Pacbase_35/A0W arkbench/workstation/help/htm_en/commonyindes. htmPtoc=T aC_Global txt&file=sdogg---j G

5

Introduction = Global WorkbenCh

Workbench - Browser

Data Element - Browser

Segment Data Structure - Browser
Segment - Browser Welcome to the VisualAge Pachase Developer
Table Data Structure - Browser workbench.

Table - Browser

I You will discover another VisualAge Pachase as
Program - Browiser its user interface has been entirely re-

Macro - Browser designed.

Report - Browser - .
For those of you who were familiar with the

Dialog - Browser VisualAge Pachase WorkStation or the

Screen - Browser character-mode YA Pac screens, this new

Text - Browser environment will most certainly change the

Logical View - Browser way you used to work with VisualAge Pachase.

eBusiness Application - Browser | If you are new to VisualAge Pacbase, you may =
é_;l @ My Camputer

The left frame of the help displays the Table of Contents. You unfold its
entries according to your current search.

The online help structure matches that of AD workbench: online help is
subdivided into browser / tab / pane / panel / field (whether editable or
non editable field).

The last item in the Table of Contents is named "Utility Functions” and
contains the help of general functions which are not linked to any
particular entity.

* A contextual online help, accessible via the F1 function key, for each
element of the interface which can gain the focus (pane, input field, button,
etc.).
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Macro - Browser A
Report - Browser
Dialog - Browser
Screen - Browser
Tent - Browser
Introduction
Text - Definition
Text - Edition
Introduction
List of Text sections
Section Lines
Intraduction
Type ofline
Text field
Referenced Data Elem:
Print Preview |

&] Done

Begin Text Assignment

You can assign, i.e. associate, text lines to one

or more instances -- of any entity type -- for
documentation purposes.

The Begin Text Assignment smartguide allows

you to specify the targeted, i.e. documented, —
instances.

As a result, the [entity type/instance code] of
targeted instances are shown in the text field.
Without an instance code, text assignment is
effective for all instances of the specified entity

type.

With the 'I' line type, instance codes have a
maximum of & characters.

Q‘ My Camputer

The [Help] button can also be used to open a contextual help page.

NOTE: The [Help] button does not appear in all smartguides. A
‘smartguide’-type window does not gain focus (unlike each of its
editable fields, from which the F1 function key is always active). To
view a smartguide general help, consult the help of the graphic
element from which you have opened the smartguide; this help
page contains a link towards the smartguide help.
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Chapter 2. Connect to Administrator & Developer
workbench

Startup of a module
The start-up files are :
*  wb_admin.bat
*  wb_batch.bat
*  wb_cfm.bat
*  wb_dialog.bat
*  wb_eBusiness.bat
* wb_global.bat

*  wb_services.bat

These files are located in the Administrator & Developer workbench
("adworkbench”) root directory.

You can also start an AD workbench module via the Windows desktop which
includes the "VisualAge Pacbase 3.5 Components’ section in the 'Start’
Menu/’Programs’ choice, with the following subsections:

Administrator-Developer workbench
Administration
Batch
cfm
Dialog
eBusiness
Global
Services Modeler

Connection smartguide

The connection smartguide - VisualAge Pacbase login - is here to help you
connect to the appropriate VisualAge Pacbase Database and/or local
workspace.

For a detailed information on input fields, use the [Help] button in this
smartguide.

When you work within your workspace only, you work in "disconnected
mode’ (see Chapter 5: "Workspace, instances import, Off line mode”).

© Copyright IBM Corp. 1983,2004 11



NOTE: When more than one workspace is saved on your machine, a dialog
box automatically opens and prompts you to choose the workspace
you wish to work in.

CONNECTION TO ADMINISTRATOR WORKBENCH

A number of administration topics are relevant at the Database level only, one
topic being site-specific.

The following lists give the entities/topics available according to the selected

option.
SITE OPTION DATABASE OPTION ANY OF BOTH OPTIONS
Database Library Optional Command Lines Set
Meta Entity Profile
User Relation User
User Entity PacTransfer
Input Aid Administration Document
Document Access Key
Environment (SCM) License
[Sessions] [Security]
[Parameters]

The Site or Database option is selected via the ‘Database’ field which displays
the list of operating Databases. This list is set by the Bases.ini file ('common’
directory), created at installation. To complete or correct this list, refer to the
[Installation Guide - Server & Client components |chapter ‘Installation of client
components’, subchapter 'Editing Communication Parameters’, section "The
bases.ini file’.

IMPORTANT Some prior administration operations are required in Administrator
workbench in order to make a VisualAge Pacbase installation fully
operational. These operations are documented in the next chapter,
"Prior administration actions’.

CONNECTION TO DEVELOPER WORKBENCH

If the selected VA Pac Database is under DSMS control and/or if you have to
work in a frozen session, in order to connect the first time to Developer
workbench, you must specify this work context in the connection
smartguide’s second page, opened with the [Next] button.

A work context is necessarily defined by a given session (current or frozen),
and also a Change number if the selected VA Pac Database in under DSMS

control.

Your work context is memorized. Your next connection will carry on your
prior context, unless you need change it. In that case, press the [Next] button.
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EWelcnme to YisualAge Pacbase x|

Select your working context

Working session
i+ Current session

" Versioned session

[ s

[ Work under DSMS controf

Product code
Change number

==Back | Finish | cancel Help

IMPORTANT INFORMATION ON LIBRARY ACCESS

NOTE: Because the Library notion is irrelevant with the following entities:
Database, Optional Command Lines Set, Profile, User, PacTransfer,
Access Key, License, and Administration Document (all accessed via
the Administration workbench), please disregard this section in these
particular work contexts.

As opposed to the VA Pac character-mode interface or the VA Pac
WorkStation, you no longer need specify a Library each time you connect to
the workbench. Only when you start for the very first time a module on a
given Database, the list of the Database Libraries automatically pops up to
enable you to choose the initial work Library for the Workbench.

~
To change Libraries during your work session, click the ## jcon.

Each time you reconnect to this module in the the same Database, the last
Library selected is automatically set as your work Library.

Chapter 2. Connect to Administrator & Developer workbench 13



For more information, refer to the 'Sessions, Libraries, views’ chapter.

Linguistic version

By default, the language used in the connection smartguide is that of your
machine’s operating system.

If this language is not supported by the current VisualAge Pacbase
installation, it defaults to English.

This default option may be modified via the parameter
-Tang

in the (x.bat) file used to start the x module of AD workbench. These files are
stored in the root directory of Administrator & Developer workbench
("adworkbench’).

In the current version of AD workbench, the authorized values for this
parameter are the following;:

fr French
en English

Once you are connected, i.e. authenticated as a VisualAge Pacbase user with
an associated working language, AD workbench will display this language.
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Quick start

Vhat doyou wantto do ?

Hyifmpod  |Data Elements -

L]

L]

Create |

© Goto the Warkbench

-
?

S

JAVA

[ Show this window at startup

] Cancel

By default, the Quick Start smartguide pops up once you have chosen your
connection context to AD workbench. To inhibit this option, uncheck the
"Show the window at startup’ box; you will directly and systematically open
the Workbench.

This smartguide proposes you to import or to create instances or to go
straight to the workbench. This last action is also possible by clicking the
[Cancel] button.

NOTE: A great number of 'Preferences’ are available and allow you to
customize your Workbench. Before working in your Workbench, it
may be useful to verify the default options and -- if needed -- modify
them. For more information, refer to the 'Preferences’ chapter.

Non Administrator readers can ignore the two following chapters, especially

dedicated to Administrators.

Chapter 2. Connect to Administrator & Developer workbench 15
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Chapter 3. Prior administration actions

After the server-side installation of VisualAge Pacbase, some prior
administration actions need to be performed in order to have a VisualAge
Pacbase installation that will reliably operate.

This chapter does not document these actions in detail, but presents them
giving the most relevant process.

The detailed documentation can be consulted in the online help of
Administrator workbench.

To carry out a VisualAge Pacbase installation, an Administrator must execute
the following operations, preferably in the order recommended below:

1. Declare the Access Key
2. Define the generation Targets

3. Activate the Access Key (and retrieve the generation Licenses in case of
Key renewal).

4. Reference the VA Pac Database(s)
(install the Database(s) at Server level after this referencing)

5. Initialize Libraries

6. Manage the Security Parameters (RACF/TopSecret, rules on passwords,
DSMS)

7. Create User Profiles

8. Create Users

9. Create/Attribute Licenses

10. Create Optional Command Lines Set

In case of key renewal, the operations 1., 2., 3., and 9 only are to be executed,
with the operation 9. often proved useless.

A VA Pac Administrator needs to perform many other operations; they are
presented in the 'Other administration operations’ chapter.

Administration different levels

Administration tasks do not all require the same authorization level since
these tasks are extremely various and therefore their impact is of more or less
importance.

* SPECIFIC ADMINISTRATION AUTHORIZATIONS

© Copyright IBM Corp. 1983,2004 17



These authorizations involve the following topics:
1. Parameters,

2. Optional Command Lines Sets (OCLS)

3. PacTransfer

4. SCM (Configuration environments)

5. One or more Libraries (individually identified)

This authorization allows to modify the Definition of the selected
Libraries and to update instances disregarding their options on extracted
lines.

Each of these authorizations are granted by the Database Administrator:

— from the User’s Profile, in the 'Definition” tab and possibly in the 'SCM
Authorizations’ tab for Database-specific SCM authorizations (point 4.
above). At this Profile level, Library-specific authorizations (point 5.
above) are granted in the 'Repository Authorizations’ tab only.

— and/or from the User’s browser, in the ‘Repository Authorizations’,
‘Parameters Authorizations’, and 'SCM Authorizations’ tabs.

The functions corresponding to the points 1., 3., and 4. above are
documented in the next chapter ‘Other administration operations’, the
OCLS management (point 2.) is presented at the end of this chapter.

* DATABASE ADMINISTRATION AUTHORIZATION

This authorization allows to manage the characteristics of a Database which

include the creation/initialization of its Libraries, the management of

sessions, Meta Entities and User Relations.

This authorization is granted by a Site- or Database Administrator:

— from the User’s Profile, in the 'Definition’ tab, ‘Global Access

Authorizations” panel, with the "Administrator’ value in the ’Libraries’
field.

Even though this authorization is valid for all Databases/ all Libraries, it
must not be mixed up with the Site Administration authorization (see
below for details).
A Database-specific authorization is defined in the Profile’s "Repository
Authorizations’ tab, the “All Libraries” option must be selected.

— and/or from the User’s browser, in the ‘Repository Authorizations’ tab,
the “All Libraries” option must be selected.

The Database(s) administration-related operations are documented in this
chapter or in the next chapter.

* SITE ADMINISTRATION AUTHORIZATION

This authorization allows to manage the characteristics of a VA Pac site. It
covers all aspects of access authentications and also includes all the
capacities given by a Database Administration authorization.
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This authorization is necessarily granted by another site-Administrator in
the 'Definition’ tab of the User browser. It cannot be qualified at the Profile
level nor in any other User browser’s tab.

All the site administration-related operations are described in this chapter
('Prior administration action’).

Access Key declaration

At all times, access to the different VisualAge Pacbase features at your site is
under the control of one active Access Key.

Also, if several VA Pac Databases are being used at your site, all Databases
are necessarily controlled by the same active Key.

There may be other Access Keys (eg. temporary test, pending renewal, expired
Access Keys) but there is only one “active” Key at a time.

When installing VisualAge Pacbase, whether the first installation or that of a
new version, you need enter, online in Administrator Workbench, your
site-specific Access Key, previously communicated by the VisualAge Pacbase
Support.

Once the input Key is authenticated by a dedicated VA Pac server program,
you will have to enter additional information to turn this Key into actual use
licenses personally assigned to individual VA Pac users.

WHAT INFORMATION DOES A VA PAC ACCESS KEY CONTAIN ?

Basically, access to VisualAge Pacbase falls into two categories: Update facility
and Build facility.

* Update facility allows for a read and/or write to the VisualAge Pacbase
Repository, whether in online or batch mode.

Online access to Update facility is qualified in the Access Key by one of the
following characteristics:

— ’Designer’ for the Pacdesign module in the VisualAge Pacbase
WorkStation.

— ’Developer’ for Administrator and Developer workbench and the
Pacbench module in the VisualAge Pacbase WorkStation.

"Text User Interface” for VA Pac in character-mode.
— ’Reader’ for consultation only.

The Access Key includes the number of seats bought, for each of the above
categories, as defined in the purchase agreement. The combined notions of
category and seat make up the Use Right notion.
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NOTE: Access to the Site Administration workbench is not submitted to
license control.

* The Build facility allows to trigger the VA Pac generating capability. The
Build facility includes two options:

— The eBusiness Build Facility,
— The Traditional Build Facility.

Access to Build facility is characterized by one or more features, a feature
being an indicator of the number of targeted Build environments. Such
feature can be a:

— Mono-Target,

- Bi-Target,

— Multi-Target.

An embedding principle applies: a multi-target necessarily implies the
purchase of a bi-target which in turn requires the purchase of a mono-target
feature.

The Access Key includes the number of seats bought, for each feature, as

defined in the purchase agreement. The combined notions of feature and
seat make up the Use Right notion.

Generation targets definition

An Access Key provides for a given number of use rights. Concerning build
rights, to transform a Use right into Use license, you first have to define the
build target for each feature (mono-, bi-, or multi-targets).

The Access Key creation smartguide displays a second page which content
depends on the context.

FIRST (OR TEST) ACCESS KEY

This page displays the list of features associated with the Key. You will have
to define the build target for each feature (mono-, bi-, or multi-targets)
expected in the Key.

KEY RENEWAL

In most cases, when a Key is renewed, the build targets remain unchanged on
your site.

However, as the combinations of features (mono-, bi- or multi-targets) of the

current and the renewal Key may not be strictly identical. You will have to
match current features with features of the renewal Key:
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For features of the renewal Key without a match in the current Key, you will

have to define their respective build targets in the list of Use Rights (Use
Rights tab, Access Keys browser).

Key activation/Generation licenses retrieval

To activate an Access Key, all of its build targets must be defined.

A created Access Key has to be activated in due time, to make it immediately
operational.

In the Access Keys list, select the Key to be activated, then select the "Activate
this key” choice in the popup menu or ‘Selected” menu.

NOTE: This choice is available for ARCHIVE Access Keys which have not
reached their expiration date and whose Build targets are all defined.

RETRIEVAL OF BUILD LICENSES BY TARGET
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In a renewal context, all Update Use Rights licenses are automatically
transferred to the new Key.

For Build rights, you will use the Key Activation smartguide to check the
retrieval of Build licenses.

You match a current target with a target in the new key; licenses of concerned
Users are automatically transferred to the new key.
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As a result, the Access Key renewal will cause a minimum of license-level
operations and virtually all users benefit from a non-disrupted VA Pac access.
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Following this operation, there may still be licenses without owner. It is also
the case for a very first Access Key or a test Key. after the Access Key
activation.

In these two last contexts, you will assign licenses in the "Use Rights” tab of
the Access Key browser or in the "Users” browser of the workbench.

For additional information, refer to ‘Licenses creation’ subchapter.

VA Pac Database(s) referencing

Any development Database on-site must be defined in the administration
Database. You do so via Administrator workbench ("Databases’ tab) with a
’Site” mode connection.

NOTE: The BVAP test Database, which is delivered at installation is already
declared in the administration Database.

To define a Database, you need to give it a logical code, a label and a
transaction code. Afterwards you cannot modify the Database code. But you
can change its label and/or transaction code.

IMPORTANT: Once a development Database is defined, you can install it.
For details on this operation, refer to the |Insta11atio;|
[Guide /Server & Client Components | chapter “Installation of
Server Environment”, subchapter "Installation of the
Development Database’.

Libraries creation

For complete details on the Library concept, refer to the Reference Manual
entitled the [VisualAge Pacbase Metamodel and Repository,

NOTE: Libraries management is strictly reserved to the Database(s)
Administrators.

The creation of a new Library is a two-fold operation:

1. The Database Administrator first creates the Libraries network, and
additional Libraries later, via a batch procedure (PACS). User input
includes the Library code, and if any, the parent Library.

For complete details on the PACS procedure, consult the [Administrator’s|
Manul.

Once created via the PACS procedure, a Library is either ‘virtual’ or 'not
initialized’.
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2. Then, the Library’s characteristics are defined online in the 'Definition’,
‘Generation’ or ‘Option’ tabs of the Library browser.

In the "Definition” tab, the ‘Status’ field can take the following values:
e Virtual (default value)

The Library was created via the PACS procedure for future development
projects, giving this latter a reserved position in an existing branch of
the Database Library tree.

NOTE: Libraries with this status are visible to Administrators only.
* Not initialized

The Library was created via the PACS procedure but its name and other
characteristics remain to be specified. Such Libraries are not ready yet to
receive development specifications.

* Initialized (this status cannot be modified)
The Library’s name and characteristics are complete; it can receive
development specifications.

To visualize which entities are under DSMS control, click the '+ icon in

the tool bar. Concerning DSMS, see also 'Security parameters management’
below. For a complete information on DSMS, consult the [DSMS Reference

For the detailed documentation on the tabs of the Library’s Browser, refer
to the online help.

Security parameters management

The security parameters are managed from the workbench browser and from
each entity browser, via the "Window” menu, ‘Open Security browser...” choice:
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* in the 'Definition” tab:
- You define the type of security system to be used (RACF, TOPSECRET,
or none), as well as the (resource) class in which VA Pac (logical)

resources are defined. You also indicate whether the resources are
defined in VA Pac, RACF or TOPSECRET.

Information on RACF and TOPSECRET implementations in the server
environment is available in the [ VA Pac Installation Guide’) Chapter
"Installation of Server Environment’, Subchapter ‘Other Installations’,
Section 'Security System Interface’.

—  You also set the rules for password definition, only if no security system
is being used.

* In the 'DSMS Control’ tab, you set under the control of DSMS all the
updates carried out in the VA Pac Database. When connecting to a VA Pac
Database under DSMS control, users are required to enter a Change
number.

For a complete information on DSMS, consult the [ DSMS Reference|

For detailed information on the Security browser, consult the Administrator
workbench’s online help.
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User Profiles creation

A Profile defines a group of VA Pac users who share the same authorizations
regarding Libraries, Procedures, Parameters, and Configuration Environments.

Authorizations are first defined at the global level, i.e. for all VA Pac
Databases managed by the Administrator workbench and where
authorizations on Libraries, Procedures, Parameters, and Configuration
Environments are each considered as a whole.

These global authorizations may in turn be redefined at specific levels; in
relation to selected Database(s) only.

A Database-specific authorization level is granted in order to qualify (restrict
or broaden) the global authorization.

NOTE: Specific authorizations on Parameters are not Database-related. They
are specific in the sense that each authorization is directly assigned in
relation to one of the five parameters:

* Error labels, Text labels and Special characters (managed via the "Window’
menu, ‘Open Parameter browser...” choice). See the ‘Other administration
operations’ chapter,

* Optional command lines set (dedicated browser). See the corresponding
subchapter,

* PacTransfer parameters (dedicated browser). See the ‘Other administration
operations” chapter.

A Profile remains a set of default values as Administrators have the possibility
to modify them for any given user. For more information, see the next
chapter.

For a detailed documentation on the Profile browser’s tabs, consult the online
help.

Users creation

The "User” entity (not to mistake for "User entity’ entity) allows
Administrators to register and manage the VisualAge Pacbase users.

User-related information includes data such as code, name, Profile, password,
license(s), access authorizations (Databases, Parameters, and Configuration
Environment).

You can modify, for each User, authorizations associated with the User’s
Profile.
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You also initialize, for each User, the generation scripts necessary to execute
the Generation-Print procedure (GPRT).

The different tabs of the User browser are:
*  Definition

NOTE: An Administrator (re-)initializes the User password and the User
changes its password in this tab.

* User details
* Licenses

The licenses management is presented in the specific subchapter 'Licenses
creation’.

* Repository Authorizations

These authorizations are divided into two categories: authorizations on
given Library(ies) and authorizations on given procedure(s).

e Parameters Authorizations:

Error labels, Text labels, and Special characters (managed via the "'Window’
menu, ‘Open Parameter browser...” choice). See the ‘Other administration
operations’ chapter,

Optional command lines set (dedicated browser). See the corresponding
subchapter,

PacTransfer parameters (dedicated browser). See the ‘Other administration
operations’ chapter.

¢ Configuration Environment Authorizations (SCM)
See the 'Other administration operations’ chapter.
* Generation scripts
See the ‘Generation’ chapter.

*  Connections

For more details on the User browser’s tabs, consult the online help.

Licenses creation

Assigning an adequate number of licenses is the Administrator’s
responsibility, no quantitative control is performed while assigning licenses to
Users.

Each time a User signs on, its access is dynamically controlled: the number of
active Update and Build licenses cannot exceed the number of purchased

seats.

Also, a build authentication is performed for each generation request.
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CAUTION: Update and Build licenses become active the first time their
owner signs on, and become inactive after a 3-month period of
non-use.

As a result, there may be inactive but owned licenses; they are not taken into
account by the dynamic authentication process.

Save for licenses automatically retrieved from the current licenses (see "Key
activation” subchapter), user licenses may be assigned from:

 the Use Rights List (Access Key browser)

A quick assignment tool allows you to rapidly assign a Use Right’s license
to several selected users.

The opposite operation is also possible; you can withdraw a license to
several users.

* the Users List ("Users’ tab)
From this list, you assign Use Rights to individually selected Users.

Also, from the Users List, licenses can be transferred from one user to another,
allowing the flexibility to respond to current staffing conditions.

NOTE: Assigned licenses necessarily belong to the currently active Key.

Optional Command Lines Set (OCLS) creation

The Generation-Print (GPRT) procedure may include in its generated job
stream the command lines that are necessary for subsequent processing such
as program assembly, compilation or link-edit.

A job stream is made up of all the generated source for a given entity type,
requested by a given user, at a given session and from a given Library.

Optional Command Lines Sets (OCLS) may be used:

* To control the whole job stream execution, inserted BEFORE or AFTER the
generated job stream.

* In relation to one generated instance, inserted just BEFORE or immediately
AFTER its generated source.

Each of these four use contexts identifies a specific option type for an OCLS
instance.

IMPLEMENTATION AS GENERATION STANDARDS

VisualAge Pacbase allows you to define OCLS instances adapted to your site’s
needs and make them available to all developers.
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OCLS instances may be set as defaults specifically to given Libraries
(Generation tab, Optional Command Lines Set panel. These defaults apply to
the Job Stream and/or to the Program entity only.

Also, developers have the possibility to choose the OCLS adapted to the
instance to generate, either at the instance level or by directly including it in

the Generation request. See also the ‘Generation” chapter.

To manage OCLS, you need the corresponding authorizations, granted by an
Administrator, in your Profile browser and/or in your User’s browser.

For a detailed documentation on the Optional Command Lines Set browser,
consult the online help.
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Chapter 4. Other administration operations

This chapter briefly presents the optional administration actions which may be
performed from Administrator workbench.

For a detailed information on the implementation of the functions described
in this chapter, consult the online help.

Parameters
These parameters are:
* The Special Characters for keywords management,
¢ Customization of the Error labels fixed part,
¢ Text labels.

To manage theses parameters, you need the corresponding authorization,
granted by an Administrator, in your Profile browser and/or your User’s
browser.

These parameters are managed via the "Window” menu, ‘Open Parameter
browser...” choice.

Sessions

You manage sessions via the ‘File’ menu, "Manage sessions...” choice. This
function is also available in all the modules of Developer workbench.

NOTE: To manage sessions, the ‘Database administrator’ authorization at
least is required.

Managing sessions enables you to manage more than one version of an
application. You can choose to manage sessions or to freeze the current
session by checking the corresponding box and by selecting the [Next] button
which is then available. You can also check both boxes. In this case, the list of
the frozen sessions of the Database will be displayed first, and if you select
the [Next] button again, you will be able to launch the freezing of the current
session.
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PacTransfer

Procedures’| manual.

The purpose of PacTransfer is to provide an easy versioning of the
developments made in a VisualAge Pacbase Database; it automates transfers
of update transactions between two sessions or more.

PacTransfer scans the VA Pac archived Journal file and reads the
Administration Database. This Database stores transfer parameters which
control the transactions.

The transfer parameters define one or more source environments. Each can
correspond to one or more target environments.

PacTransfer selects, from the archived Journal file, transactions that match the
criteria defined via these transfer parameters.

It then generates update transactions for the target environment(s) also
defined with these same transfer parameters.

These transactions are used by the VA Pac batch update procedure (UPDT). If
the VA Pac Database is under DSMS control, such updates are automatically

included in this control.

PacTransfer processing is thus based on transfer parameters defined by the
user in Administrator workbench.

These parameters are: sessions numbers, Libraries, Change numbers and User
codes.

They must be created and defined prior to any PacTransfer operation.

For more details on PacTransfer procedures, see the [ Administrator’s Batch|

The PacTransfer function is driven from the tab of the same name, in
Administrator workbench.

To update PacTransfer tabs, a User must at least have the corresponding
authorization, granted by an Administrator in the corresponding Profile
browser and/or in the concerned User browser.

Support Configuration Management (SCM)

Batch, Dialog and eBusiness applications are built with generated instances of
several entity types.
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These instances are stored in the Database in the form of logical source
programs. These source programs are handled by developers.

The generation of an instance (i.e. the production of an executable module)
can be performed at various steps of its life cycle: development, test, system
acceptance, shipment for operations, maintenance (bug corrections or
evolution).

At each step, the instance is generated in a different physical environment.
The various physical environments are differentiated by their physical
implementations (test or operations system library) and are managed by
different activities (design, operations, ...).

In the ‘Configuration Environment’ tab, you define a logical environment.
Then when you execute the batch generation procedure (GPRT) or one of the
SCM module (SUPPORT CONFIGURATION MANAGEMENT Tools Interface)

procedures, you will pilot the procedure output by indicating the appropriate
environment.

The parameters specified in the configuration environment define the physical
target of the generation or production turnover or simulation.

For more information about batch procedures, refer to[The Developer’s
Procedures’| Manual for the GPRT procedure, and to|The Administrator’s

Procedures’| Manual for the SCM procedures.

SCM is driven from the ‘Configuration Environments’ tab, also available in
the eBusiness, Dialog, Batch modules and Global workbench.

To update SCM tabs, a user must have at least the corresponding
authorization, granted by an Administrator in the corresponding Profile
browser and/or in the concerned User browser.

Customization entities

VisualAge Pacbase manages standard entities, such as Data Element or
Segment, which represent specific concepts in an application life cycle. They
constitute the core of the VisualAge Pacbase Metamodel.

You can customize this Metamodel by creating new entities to meet your own
specific business needs.

VisualAge Pacbase enables you to:
* Define your own entities,
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* Customize their descriptions,
* Define the relations needed between these entities and any other entities.

The VA Pac Metamodel customization is ensured by three entities: Meta
Entity, User Relation, managed via dedicated browsers, and User Entity,
integrated in the browser of the Meta Entity they belong to.

These entities are also available in Global workbench.

NOTE: A Database Administrator authorization at least is needed for the
Meta Entity and User Relation browsers. The User Entity browser is
accessible by any User having an Update authorization on the
concerned Library.

The three next sections give a brief functional presentation of these entities.

For a detailed information about the corresponding tabs, consult the online
help.

Meta Entity

NOTE: the 'Meta Entity” entity was referred to as "User Entity’ in the versions
prior to the 3.0 Version.

The Meta entity (ME) enables you to:
* Define a new concept,
* Customize the description of this concept listing its characteristics that are
defined in the Repository by instances of the Data Element entity.
User Relation

The User Relation entity (UR) allows you to create links between two entities
(standard entity or Meta Entity). The cross-reference will be automatically
managed. A User Relation is characterized by the target entity of the relation.

"Called instances’ tab

To create a link between an instance A and an instance B via a User Relation,
use the "Called Instances’ tab in the browser of instance A.

Choose the appropriate User Relation, and then specify the code of the
instance B.
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User Entity

User Entities are instances of a given Meta Entity.

NOTE: The name "User Entity” in VA Pac versions earlier than 3.0 was "User
Entity Occurrence”.

A User Entity’s Definition and Descriptions tabs entirely depend on the --
user-defined -- Descriptions of the corresponding Meta Entity.

If you need information on how or what to enter in any of these tabs’ fields,
consult the Meta Entity designer (usually, the VA Pac Administrator or the
Project Manager).

Input Aids

This subject is treated in the 'Documentation functions’ chapter.

It must be mentioned here as the Input Aids browser is present in
Administrator workbench.

NOTE: No specific authorization is needed to specify Input Aids instances.
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Chapter 5. Workspace, instances import, Off line mode

Workspace

WORKSPACE DEFINITION
A workspace is defined for one module, Database, User, and session.

It contains all instances imported from the VA Pac Repository and all
instances you have created.

The workspace is therefore the local image of your current work on VA Pac
instances.

IMPORTANT RECOMMENDATION

A workspace must NOT be considered as a persistent resource to be kept
permanently.

It should only contain your day’s work pile which must be systematically
uploaded in the VA Pac Repository.

The Repository is the only secured and shared storage place for the VA Pac
instances.

This is why, for instance, working on a long-lasting workspace would only
increase the risk of update conflicts with other users.

However, you may save your current workspace ('File’ menu, ‘Save
workspace locally’ choice), in particular when closing the workbench: your
instances will be stored locally with your latest updates (whether uploaded or
not in the Repository).

NOTE: In 'File’ / 'Preferences’ / "Workspace’, the “Save workspace locally
when closing application” option is a default option.

You can even save an already saved workspace under another name ('File’
menu, ‘Save workspace locally as...” choice). As a result, you can manage
several workspaces for one [module-Database-User-session].

You can set your own preferences regarding your workspace (in 'File” /
"Preferences’ / "Workspace’). For complete details, see further in this chapter.
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NOTE: Preferences are set for one module. As a result, they will necessarily
be identical for all workspaces saved for one module.

Instances import

To work on any instance, whichever the entity, it must exist in your
workspace. So you must import the wanted instance(s) from their storage
place, the VisualAge Pacbase Repository.

The import utility imports all the instances which match your import criteria,
but also the instances called by the imported instances, if they do not already
exist in your workspace.

At first, Definitions only are imported (to minimize the import size); the entire
instance folder is imported when the instance opens up.

The branch of the subnetwork explored during the import is the one currently
selected for the display of the entity instances in the workbench.

You can import instances in two different ways:

* Import instances from the Repository into your current workspace, via the
import window which you open from:
— the Quickstart window. In this case, you select the entity whose
instances are to be imported.

— any Workbench list. You import instances, of the entity whose tab is
displayed, by clicking the import icon (blue down-arrow), in the toolbar
or the 'Import” choice in the popup or ‘Selected” menu, or the menu
whose name displays the ‘[Entity_name]” menu in the menu bar.
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You choose between several possible import types:

instances import, ‘from ..." an entity code.

unit import, to import instances one by one. In that case, the code is
required.

instances import, ‘from ..." an entity label.

instances import by keywords.

Click on the [Import] button: the list of instances concerned by your import
request is displayed in the bottom pane of the smartguide.
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This function allows you to visualize lists of instances defined in the
Repository.

Select in this list the instances you want to import and click the [Add]
button.

* Import instances from the Repository and create new instances if the
instances you indicate do not exist in the Repository. You open this
smartguide from a list of instances by clicking on the import icon (blue
down-arrow, with bright point) or by selecting the 'Import/Create by code’
choice from the popup or 'Selected” menu, or from the [Entity_name]’
menu in the menu bar.

Smart Guide x|
ey
Import Data Elements = T 72 E

i

Enter the codes of Data Elements that you want to import or create

(Use snaces oF cormas to separale theml

What do you sant to do if some ofthem do not existyet ?
& Open creation Smart Guide

" |gnore

| Finish | Cancel

You choose to import/create instances if you already know the codes of
these instances.

If you have entered existing codes, the instances are added to the
workbench list.

If the codes you have entered do not exist, you can:

— either ignore them,

— or create the instances via the creation smartguide which opens up.
Click [Finish] to start the import.

For a detailed documentation about the import utility and import criteria,
consult the online help.
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Instances are not locked on the server when you import them. However,
when you save your updates, a timestamp is assigned to check whether this
instance has been updated by another user since your import.

In such case, a warning is displayed and you must then decide whether or
not to save your updates (and thus overwrite the updates made by other
users).

Work in Off line mode

Working in off-line mode is useful when:
* A network/gateway/host breakdown occurs,

* No host can be accessed (if you are working on a laptop or out of your
office).

When you work in off-line mode, you can create, delete instances and, modify
any instance existing in your workspace. But any action that requires a host
access is unavailable.

Before closing your workbench, make sure you save your workspace. You will
upload your updates at your next connection to the host.

It is therefore recommended to let the default preference ‘Save workspace
locally when closing application” (in ‘File” / "Preferences’ / "Workspace”)
selected.

You can work in off-line mode in several ways:
* Systematically start in off-line mode

Deactivate the default option 'Start application in connected mode” in "File’
/ 'Preferences’ / "Workspace” / "Off Line’.

* Exceptional start in off-line mode

In the connection smartguide, uncheck the default option "Start application
in connected mode’.

e Switch from connected to off-line mode
In the 'File’ menu, select the "Disconnect’ choice.

The "Reconnect” choice will immediately restore your connection.

NOTE: In 'File’ / 'Preferences’ / "Workspace’ / 'Off Line’, the ‘Save when
closing creation SmartGuides’ preference ensures that for every
creation smartguides closing, the instance is immediately saved in
the VA Pac Repository. This option is automatically inhibited when
the work session is in off-line mode.
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Workspace management

Workspace Manager browser
Workspace Manager gives you an overall view of your workspace.

To access the Workspace Manager, in the "Window” menu, select the
"Workspace Manager’ choice.

This window displays four tabs, described below.
"LOCAL UPDATES’ TAB

This tab displays the list of instances modified on local in your current
workspace. You can also perform the following operations:

* Recompute list

To refresh this list, click the 'Recompute list” choice in the popup menu or

the "Updated Entities’ menu in the menu bar, or else click the toolbar
icon.

e Save all

To save all your updates on the server, click the ‘Save all’ choice in the
popup menu or the "Updated Entities” menu in the menu bar, or else click

the toolbar icon. The instances saved are suppressed from the list.

If you perform a ‘Save all’ on a selected instance, the ‘?;] icon which was
present opposite the instance name in the list disappears but the instance
saved remains displayed in the list.

¢ Refresh all

You may wish to retrieve the current server version of instances already
imported on local.

To do so, select the "Refresh all’ choice in the popup menu or the "Updated

P,
Sl
Entities’ menu in the menu bar, or else click the ¥#2 toolbar icon.
Local changes are then discarded.
* Discard all changes

If changes made are actually not to be saved, select the 'Discard all
changes’ choice in the popup menu or the ‘Updated Entities’ menu in the
v

menu bar, or else click the "1 toolbar icon.

You then recover the server version which was last imported.

"ALL PROBLEMS’ TAB
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This tab displays the list of instances on which errors have been detected
while being updated on your workspace.

Whenever an error is detected on an entity’s instance, a red cross is displayed
on the bottom left of your window. This cross also appears in the list
displayed here, in front of the entity’s instance bearing the error.

You may wish to retrieve the current server version of the instances you have
imported and modified locally.

To do this, click the "Refresh’ choice in the popup menu or in the "Invalid
Ay

entities” menu of the menu bar, or else click the l"*’ icon in the tool bar.

When you click on an entity’s instance in the list, the label of the error
detected is displayed on the bottom of the pane.

If you double click on this instance, you open the entity’s browser.

"LIBRARIES” TAB

This tab displays the list of all instances present in your workspace in an
ordering by Library.

NOTE: In the Administrator workbench, the Libraries tab is inactive if you
are connected in a Site-Administration mode.

'LOG” TAB

This tab keeps track of all the communications exchanged between your
workspace and the server.

It displays brief messages which report the actions performed and changes
made in your current workspace. It also locates errors and thus provides an
interesting source for debugging in case of server error.

Workspace resynchronization

You can, at any moment, resynchronize your workspace to refresh the local
instances with their current version from the Repository. To do so, select the
"Resynchronize the workspace’ choice in the "Workspace” menu.

This choice is also available via the 'Resynchronize workspace at startup’

option in 'File’ / "Preferences’ / "Workspace” / "Off Line’, but in this case,
resynchronization is effective each time you open the workbench..
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If you select this option, make always sure you save your updates in the
Repository, otherwise they would be lost the next time you will open the
workbench.

Workspace clean up
You can remove the entities you no longer need from your workspace.

To do so, select the "'Workspace Clean Up’ option in the "Workspace” menu

You can select the instances to keep. These instances will not be cleaned up,
as well as all their referenced instances (lines which are called depending).

EXAMPLE: If you exclude a Segment from the clean up, the Data Elements it
calls will automatically be kept in your workspace.
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Chapter 6. Sessions, Libraries, views

Working context display and modification

The connected user name, the VA Pac Database code, and the session are
systematically displayed between brackets in the title bar of all workbench
windows.

NOTE: The workspace name is also displayed (in quotation marks) if you
work in a workspace already saved, and therefore named.

If you are connected to Administrator workbench in ‘Site” mode, the user
name only and possibly the workspace name are displayed.

If the Database is under DSMS control, you can view and/or modify the
DSMS Product code and Change number via the ‘File’ menu, ‘Change DSMS
Context’ choice.

To change the session number (and the DSMS context), in the "File” menu,
select the ‘Open a new session...” choice. This operation directly opens a new
Workbench. The initial Workbench remains open.

NOTE: If you just want to compare an instance already open with its version
in another session, it is not useful to open another session. The
workbench contains a compare/assign utility. Fore additional
information, refer the ‘Search and comparison of instances’ chapter.

To change the user code and/or Database code, you must restart the wanted
module to open a new workbench.

Libraries access

~
To change the work Library, open the Libraries list by clicking on the <#
icon in the bar located under each instances list.

CAUTION: This change will be applied to all tabs of the given browser.
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The Libraries list is presented as a tree. Its branches show the hierarchical
relations between the Libraries defined in the VA Pac Database.

To display dependent Libraries, click on the "+” button which is located just
before the Library icon. The Libraries dependent on this Library are
displayed.
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Click on the ’-” button to unfold the list.

If you find neither the "+ nor the ’-’ sign before a Library icon, it means that
this Library has no dependent Library.

LIST CONTENTS

The contents of the list depends on your current work context. In an instance
browser, as no operation is possible in Libraries higher than the Library where
the instance is defined, these Libraries are not listed.

Otherwise, the Libraries list is automatically updated on your workspace each
time you connect to the VA Pac Repository.

During a work session, it may happen that changes are made on the Database
Library structure, Library names, etc.

To display the updated list, click on the 'Refresh all Libraries” choice in the
"Workspace” menu.

INSTANCE BROWSER AND LIBRARY

When you open the browser of an instance, its tabs open in the Library
currently in use in the browser from which you have opened this instance.

This browser may be the workbench browser (instances list) or another
instance browser (Data Structure for Segment, Dialog for Screen, Meta Entity
for User Entity).

Also, when you open a second-level browser (description-level browser), its
tabs open in the Library currently in use in the instance browser.

NOTE: This is a new behavior starting with the 3.5 Y02b workbench release.

~
Changing Libraries is therefore always an explicit operation: click the ##
icon, left-positioned in the tool bar of all tabs or panes. Choose a new Library
in the list that opens.

When opened from an instance or description line browser, this list only
displays Libraries dependent from that where the instance or description line

is defined.

Overriding lines originating in higher Libraries requires in most cases the
explicit selection of the ‘Override’ choice (‘Selected” menu).
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The new Library becomes the work Library for all the browser tabs, until you
select a new one. As a matter of fact, you can be working in as many different
Libraries as there are browsers opened.

USE TIP: To consult and edit the same instance simultaneously in different
Libraries, select the ‘Open in a new window’ choice (popup menu/right click)
and choose another Library. As a result, you will have two or more browsers
opened for the same instance.

Different views on the Repository

The work Library is the starting point to the exploration of instances within
the VA Pac Repository regarding import operations and visualization of lists
(instances or descriptions).

This work Library may be seen through different filters, called views,
documented in details below.

The change of view applies to all the tabs of the current browser.
* Upward view
This is the default value.

Display of instances from the selected Library and its parent Libraries. If
duplicates are found, only those from the dependent Library are displayed.

* Downward view

Display of instances from the selected Library and its dependent Libraries.
* Selected Library only

Display of instances from the selected Library only.
* Parent Libraries

Display of instances from the parent Libraries only (and not from the
selected Library).

* Dependent Libraries

Display of instances from the dependent Libraries only (and not from the
selected Library).

e All Libraries

Display of instances from the selected Library and its parent and dependent
Libraries.

* Upward view with duplicates

Display of instances from the selected Library and its parent Libraries. If
duplicates are found, they are all displayed.
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Chapter 7. Lists of instances

In this chapter, ‘instances list” refers to the list of instances existing in your
workspace, displayed in the current entity tab (workbench browser).

If this list is empty and if you want to work on one or more instances already
existing, you need to import them into your workspace.

You can visualize the list of instances defined in the Repository via the Ql
icon. Then, you can request the import of instances you have selected.

For additional information about import, see the "Workspace, instances
import, Off line mode” chapter.

The list of instances, in the left pane of the tab, is usually a classic list.
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NOTE: For some entities, a list with a tree-like structure is displayed.
This chapter gives the exhaustive list of possible operations from a list of
instances. These operations are documented separately, in other chapters of

this guide.
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NOTE: In this chapter, information related to the notion of Library do not
concern Administration specific entities as they are managed outside
the Library context.

DISPLAY OPTIONS

* You can change the work Library via the == icon located below the list.
This icon opens the Libraries list.

See also the chapter ‘Sessions, Libraries, views'.

*  You can also modify the view you have on lists of instances by selecting
another view in the dropdown list, on the right of the icon mentioned
above.

See also the ‘Sessions, Libraries, views’ chapter.

 If the list displays many instances, you may find it helpful to use the sort
facility. Select the “Sort by...” choice in the popup menu or in the
'[Entity_name]” or ‘Selected” (not available in tree-like structure lists) menus.

¢ Click the '% icon in the tool bar to visualize the Definition details of the
listed instances.

SEARCH OPERATIONS

You may request two different types of search
* Search instances by keywords.
* Search for references to an instance:

You search instances where a given instance is referenced. For example, you
want to know in which Segments a given Data element is called.

You can request a search in several ways

L
* (Click the ‘Search’ icon ( = ), available in the toolbar of all the workbench
tabs.

* From any list of instances, select an instance and click on the "Search
references...” or on the ‘Search local references’ choice in the popup menu or
in the ‘Selected” menu.

With the “Search references...” choice, thie search is by default made within
the VA Pac Repository.

With the 'Search local references’, the search scope is by default limited to
your current workspace.

NOTE: A search by keyword(s) is also possible with these two choices.

This function is detailed in the ‘Documentation functions’ chapter.
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PUBLISHING

With the 'Publish’ icon, you can edit documents that include instances’ lists
and descriptions.

This function is detailed in the "‘Documentation functions” chapter.
ICONS AND SIGNS

An instance list may show the following icons and signs:

« ¥ means that the instance has been modified locally, a Save is needed.

=

. shows a locked instance.

. & for Warning.
. indicates an Error.
All entities are symbolized by a specific icon.

The icon background is grayed if you are not granted authorization to update
the instance.

Example for a date Data Element: CI

The icon background is white if the instance is defined in a Library different
from your current working Library.

Example for a numeric Data Element: @

IMPORT OPERATIONS
* Import instances according to various selection criteria.

* Import or Create an instance by code.

The import function is detailed in the "Workspace, instances import, Off line
mode’ chapter.

OPERATIONS ON A SELECTED INSTANCE
* (Create a new instance

Click on the "Create a [entity_type]” in the toolbar or select the '[New
entity]” choice in the popup menu (via right click) or in the ’[Entity_name]’
or ‘Selected” menus.

* Open the instance browser
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Click on an instance and select the ‘Open’ choice (popup menu via mouse
right click or 'Selected” menu) or simply double click on the instance to
open its browser.

Open another browser for the instance

Click on an instance and select the "Open in new window’ choice (popup
menu). This choice followed by the selection of another Library allows you
to consult and edit a same instance simultaneously in different Libraries.
Visualize the Definition of an instance

Click on an instance in the list; the Definition is displayed in the tab’s right
pane.

For the following operations, select an instance in the list, click on the mouse
right button or on the ‘Selected” menu.

Override an instance

NOTE: Choice available if you are working in a Library dependent on the
Library where the instance is defined.

Copy the instance Definition

Duplicate the whole instance (Definition an Descriptions)

Lock an instance

As a result, you are the only user who can update this instance.
This function is detailed in the “Instances lock” chapter.

NOTE: The = icon is displayed opposite the instance name.
Unlock an instance

Other users can then update the unlocked instance.

Change lock owner

This choice opens a dialog box where you enter the code of the new lock
owner.

Compare

The Comparison/Align instances utilities, activated with the ‘Compare with
server value’ or ‘Compare with another session/instance” choices which
respectively allows to:

— Compare any instance in your Workspace (slave instance) with its server
version (master instance).

NOTE: If your connection session is a frozen session, the analyzed
master instance is stored in the same session.

— Compare any instance in your Workspace (slave instance) with:
- its version from another session (comparison session),
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- another instance (entity type being identical) from a comparison
session or in the same session (connection session).

From the results of the comparison, you can ask to align (totally or in part)
the slave instance with the master instance.

If the master instance has been modified -- without a Save in the VA Pac
Repository -- you can choose to use the workspace version or the server
version of the master instance.

This function is detailed in the "Search and comparison of instances’
chapter.

Generate an instance

This choice is reserved for entities for which generation is applicable, e.g.
the Program entity.

See also the ‘Generation” chapter.

OTHER OPERATIONS

SAVE

To save the changes made on an instance, select that instance, click on the

’Save’ choice in the popup menu, or else click the ‘?;] toolbar icon. That
same icon which was present opposite the instance name in the list
disappears.

REFRESH

You may wish to retrieve the current server version of an already imported
instance. To do this, select the instance, then click on the 'Refresh’ choice in

Wy
the popup menu or else click the Lt toolbar icon.
DISCARD

If changes made on an instance are actually not to be saved, select that
instance, click on the 'Discard Changes’ choice in the popup menu, or else

click the n toolbar icon.
DELETE

To delete an instance (or an object), select that instance, click on the 'Delete
choice in the popup or 'Selected” menu.

7

WARNING: The deletions of instances are immediately performed in the
Repository (after confirmation).
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Chapter 8. Search and comparison of instances

Instances search

You can search instances in several ways:

* Click the s icon in the toolbar to activate the Search utility.
The search smartguide proposes two types of search:
— Search instances by keywords.
Enter the keyword(s), your search criteria.

The keywords dictionary of a VA Pac Database is made of keywords
used in instances labels (implicit keywords) and of explicit words
entered as keywords in the instances Definition.

© Copyright IBM Corp. 1983,2004
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This search is available for all entities for which keyword management is
provided. The scope of this search is necessarily the VA Pac Repository.

Special characters and characters with accent are managed in
Administrator workbench ("Window” menu, ‘Open Parameter browser...”
choice, ‘Special character” tab). This management may have some impact
on the search results.

— Search for references to an instance.
EXEMPLE : You search all Logical views in which a given Data Element
is called.
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Enter the entity type and code of the considered instance, and optionally

the entity type, description, indeed the code of the searched instance.

¢ Select an instance in a list and click on the "Search references ... choice in
the popup menu. The same search smartguide opens up (see above), and,
in this case, already contains the entity type and the code of the selected

instance.

All of these search types are made within the VA Pac Repository and results

are shown in a three-pane window.
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The bottom pane displays the descriptions details of a referencing instance
(previously selected in the top-right pane) where the searched instance is
being used.

The left column displays the description code, the right column displays its
identifier.

You can open the Description of a referencing instance selected in the list via
a popup menu.

If you have requested a search based on one or more keywords, this pane
remains empty.

* Select an instance in the list and click on the ‘Search local references’ choice
in the popup menu.
In that case, the search scope is limited to your current workspace.

NOTE: A search by keyword(s) is also possible with the choices ‘Search
references ...” and ‘Search local references’.

Instances comparison

In all modules, except Administrator workbench, the Compare/Align Utilities
offers different options for comparing two instances, available from:
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* an instances list: you first select an instance in the list, and select ‘Compare
with server value’ or ‘Compare with another session/instance’, choices in
the popup or 'Selected” menus.

* from an instance browser: you

select the ‘Compare with server value’ or ‘Compare with another
session/instance” choices in the ‘[Entity_name]” menu.

These choices allow you to, respectively:

* Compare any instance in your Workspace (slave instance) with its server
version (master instance) in the connection session.

If your connection session is a frozen session, the analyzed master instance
is stored in the same session.

* Compare a slave instance in your workspace with:
— its version from another session (comparison session),

— another instance of the same entity type from a comparison session or
from the connection session (master instance).

Comparison results are displayed in a three-pane window.

Unlike the search results window, comparison results are not cumulative; each
comparison opens its own results window.

* The top pane lists all the differences found (tree-like structure unfolding to
differences found in the first level or second level Descriptions lines).

From this pane you can align the slave instance with the master instance at
four different levels:

All Descriptions.
The instance Definition.

This is possible only if you are comparing two versions of one instance
(entity type and instance code are identical, respectively).

One Description.

One first level Description line.
— One second level Description line.

In order to do this, first select the adequate line in the results tree, then
click the ‘Load Differences’ choice in the popup or 'Selected” menus.

Disjoint multiple selection is possible among Description lines originating
from the same Library.

With a multiple selection (whether disjoint or contiguous), in order to open
the popup menu, you need to right-click outside of the selected lines, eg
within the left margin.

* The bottom-left pane shows the differences found in the slave instance.

¢ The bottom-right pane shows the differences found in the master instance.

Chapter 8. Search and comparison of instances 59



60  VisualAge Pacbase: Administrator & Developer workbench User’s Guide



Chapter 9. Instances lock

The Lock utility enables VA Pac users to take ownership of instances and thus
prevent other users from modifying them.

NOTE: Administration specific entities cannot be locked (License or Profile
for example).

Locking an instance is carried out from the instance Definition Library or in a
dependent Library and is valid for the entire Library branch.

As a result, an instance can only be locked ONCE in a given Library branch,
ie a locked instance cannot be locked again in a higher or lower Library.

However, a locked instance can be locked in a parallel Library branch.

To unlock an instance or transfer its ownership, you must be:
e the lock owner or an Administrator,
* in the Library in which the instance was locked.

There are several ways to lock an instance:
* in the instances list,

* in the Locks Manager.
INSTANCES LIST

To lock an instance, right-click on the instance in the list and select "Lock this
instance’ (choice also available in the 'Selected” menu).

=

In instances lists, locked instances are marked with the icon.

LOCKS MANAGER
To manage locked instances, use the Locks Manager. Accessible via the

"Windows’ menu, it is user-centered. It allows you to view instances sorted by
user /lock owner.
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VA Pac users and Administrators can unlock and relock instances and transfer
lock ownership.

To check which instances are locked by a given user:

¢ (lick on l'ﬁi to Add user. Enter the user code.
* Select the code in the drop-down list.

e Press the =2 Search Locks icon.

As a result, all instances locked by this user in the current Library branch are
displayed.

NOTE: Each added user is saved in the list and therefore will also appear in
the Locks Manager windows opened from other Library branches.

To view the locked instances of all users in this Library branch, use the "All
Users” option.
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To remove a user from this list, click on the x icon to delete the selected
user.

To view the type, code, keywords, date of last update, storage Library and last
update session of the locked instances, click on the ‘Show Details” icon.

To unlock or relock a locked instance, right-click on the instance code and
select "Unlock” or "Lock’. You can also do this via the “Selected” menu.

LOCKS TAB

This tab exists in the browser of all instances which can be locked. It lists the
lock(s) associated with the instance, visible in the selected Library view for
this browser.

MIADELST Starting addrezs [column number) [Frangoize BLIN. ¥DO3 in cumrent seszion p-18578]

i
ol

File ‘Warkspace DataElement Lock Window Help

¢ L O P &

E] comment | (8 Called Instances | B} Attached Files | ] Enor Messages | (5 Assigned Text |

= -l @ ADELST Starting address (column number) Lock O
=2 by POFB in library DOA and session G475

1
8] DOAENGLISH DOCUMENTATION 5% [Upward view =]

For each lock, this tab displays the lock owner, the current Library and
session in which the instance was locked.

To unlock an instance or to transfer lock ownership, you must be:
* the lock owner or an Administrator,
* in the Library in which the instance was locked.

To unlock an instance, select the instance and click on the "Unlock’ option in
the popup menu.

To transfer Lock ownership to another user, select ‘Change lock user” in the
popup menu and enter a new user.
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To view the storage Library and last update session number, click on the
"‘Show Details” button.
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Chapter 10. Documentation functions

Comments
The '"Comment’ tab is available in the browser of all development entities.

C/CLSFBZ FB Input Aid [Blin Frangoise. Q280 in current session, workspace g i ju] ﬂ
File ‘Workspace InputAid Window  Selected Comments.. Help S

3 & & 4 8 B T 2O OO P %

Defintion =] Comment | (& called Instances | B Attached Files | a»
A e @ CLSFB2 FB Input Aid Abstract Comments - O
Comment Line
constline - Label Zonst_line - Label Part 2

war_Line - Lahel 1 . Wariahle Line - Initial Walue

war_Line - Label 2 -
@ End of sample

I
8] TLo Gestion des Lots. 3% [Upward view |

This tab enables you to:
* make or modify comments on an instance.

Such lines are identified by the 2 icon in the tab.
=
 call one (or more) Input Aid(s) using the "= icon in the toolbar, or the
'Call an Input Aid” choice (popup, ‘Selected’, or ‘Comments” menus).

Use this same icon or choice to replace an Input Aid call by another.
* enter or modify Input Aids edit fields, all aligned in the second column.

The Input Aid entity contributes to standardize, therefore facilitate, your
work; it makes repetitive input fast and easy. In addition, it allows for the
automatic display of pre-formatted input lines with or without controlled
input values. For additional information on this subject, see the 'Input Aids’

chapter.
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Texts

The Text browser is available in all eBusiness, Dialog, Batch modules and in
Global workbench.

The example in the screen image below illustrates the use of the Edition tab.
As you type in your text in the top pane, a print preview is dynamically
displayed in the bottom pane.

E AZEMLD EMLD PROCEDURE [Francoise BLIN. YDO3 in current zeszion p-18578] -0 ﬁ
File ‘Workspace Text ‘Window Help €
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Md =& A7 | Sections | O X =¥ =] GG Textlines [m}
2 Thisz procedure executes a DEFINE of the user-defined error d
message file and proceeds to the initial loading of error
messages ohtained in sequential format from the GPRT proce_
dure,
- EXECUTION CONDITIONS
Z2 1. The required authorization lewel must be 2.
2 2. TUger-defined error messages mast have
been generated wia
the GPRT procedure.
-
1 | 3
I
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in sequential format from the GPRT procedure.
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2. User-defined error messages mist have been generated via the GPRT =
4 | »

Document layout =Mone= .

The Text entity is used to document applications throughout their whole life
cycle.

* During the Analysis and Design Phases, it is used to describe processes,
procedures, operations, tasks, ...

* During the Development Phase, it is used to document Screens, Programs,
Reports...

Texts can be:

e Called in PDM Documents (or Volumes) to make documentation available
to maintenance teams and end-users.
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For complete information, please refer to the [Personalized Documentation|
Reference Manual.
This Developer workbench release does not allow access to the PDM

Document entity. However, you can connect simultaneously to the Pacbench
module of the VA Pac WorkStation.

Assigned to instances of all entity types.

A cross-reference is created which facilitates the maintenance of both the
documented instance and its assigned Text. It is visible in the "Assigned
Text” tab of this instance browser.
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File ‘Waorkspace Data Element Window Selected Help Q_.:
& %
B} Attached Files l E] Error Messages Assigned Text I =2 Locks A
e =% 4 COLOT Code [ot m|
Text Division Type Content Data Element Library  |Session

TEXTFB no | ECDLOT TLO 26450
| will ign this text B 2650

Goto Text..

I
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Used to create online help for generated online applications (Dialog
module).

For complete information, consult the online help of the Dialog and Screen
browsers.

You can also reference a Data Element code on each Description line of a Text.
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NOTE: These Data Element do not have to be defined in the Repository,
enabling you to reference - while in the design phase - properties to
be created later on.

For a detailed documentation on the Text browser, consult its online help.

External Files

Create an External File

An External File is an instance saved in the VisualAge Pacbase Repository but
which content has been created (and can be read and edited) via an
application different from VisualAge Pacbase. External Files are of all types
(with a .doc, .txt, .jpg, etc. extension).

Declaring a local file as an External File creates a copy of this file which data
will benefit from the advantages of storage in the VA Pac Repository.

This operation is performed from the "External Files’ tab, available in all
modules, except in Administrator workbench.
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To save a local file as an External File:
1. First create it in the workspace,
2. Save its contents in the Repository (‘Save” choice in the popup menu).

The data stored in the External File is saved only when the File has been
saved in the Repository.

NOTE: Once a file is an External File instance, it is recommended not to

update the original file but to edit this instance from the workbench.

An External File can be attached to one or more instances of virtually all
entity types. To do so, open the "Attached Files’ tab in the browser of the
concerned instance.
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Attach an External File to an instance

The "Attached Files’ tab allows you to attach one or several instances of
External Files to the open instance in the same way as you would attach a file
to a mail. External files can be of any type such as .doc, .pdf, etc.
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File Workspace Data Element Aftached File Window  Selected  Help S

@ g o 2 G OH a7 4

E Attached Files l% Ettar Messages l Azsigned Text ] =2 Locks Al
HA o 6 CDREL Code release Attached Files - O
Elmiddleware Middleware.doc
ElTrmpBase TrpBase.ini
> I
@] TLD Gestion des Lats. 5% [Upward view -]
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Once an External File instance is attached, cross-references are automatically
created between the File and the instance which calls it.

In this tab, you can:

e attach an External File instance,

¢ delete an External File attachment,

» perform open, edit and export operations on an
attachment.

ATTACH AN EXTERNAL FILE

To attach an External File, use the "Add Attached File’ choice ("Attached File’

menu) or the icon in the tool bar.

* If the External File to be attached has been saved in your current
workspace, you just have to select it in the list which opens up and click
[OK].

* Else, from the "External Files” tab (workbench browser), you first have to:

— either create a new External File from the file of your choice, by using

the ‘ icon.
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— or import an External File from the Repository by using the *= icon.
The new attached file appears in the attached files list of the open instance.
DETACH AN ATTACHED FILE

To detach an attached file, select the concerned File and click the "Delete’
choice in the popup menu.

NOTE: This action has no impact on the content of the Attached File, nor on
the existence of the External File in the Repository.

OPERATIONS ON AN ATTACHED FILE

Via the popup menu or the "Attached File’ menu, you can open the browser
of an External File, edit the File using the proposed application, or choose
another application via the "Edit with” option.

NOTE: A File which has been edited from the workbench is marked with a
red arrow in the Attached Files List indicating it requires a Save in
the VA Pac Repository.

You can also export an External File to a local drive of your choice. In this
way, External Files are not confined to the Repository but can be distributed
outside VA Pac, for example as mail attachments.

When exporting an External File, it is recommended to keep the default File
name proposed.

Input Aids

The Input Aid browser is available in Global workbench and Administrator
workbench.

The Input Aid entity contributes to standardize therefore facilitate the
developer’s work; it makes repetitive input fast and easy. In addition, it allows
for the automatic display of pre-formatted input lines with or without
controlled input values.

NOTE: No specific authorization is needed to specify Input Aids instances.

An Input Aid can be called by instances of virtually all entity types (including
the Input Aid entity) in the Comment tab.

The Input Aid entity includes the following specific tabs:
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* A Description tab where you define one or more constant and/or variable
lines with or without initial value.
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* A Symbolic Values tab, where you may define the authorized values for
editable parts, thus allowing input control on variable lines. This control is
effective for variable lines whose editable part length is set to '3’. This
constraint, due to internal reasons, has no impact on the actual length of
authorized values.

WARNING: When an Input Aid is called by at least one instance, you will no
longer be able to add nor delete variable lines. Also, the lengths of variable

fields can no longer be modified.

For a detailed documentation about this browser, consult its online help.

Publish

The Document browser enables you to define Documents/templates and then
to describe their content in the XML format.

You will then be able to edit these Documents in the HTML format using the
"Publish” icon in the workbench tool bar.
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Documents are related to all the entities of Developer workbench and also to
entities managed in Administrator workbench and stored in a Library (Meta
Entity, User Relation, Input Aid, Environment).

Administration documents are related to entities exclusively managed in
Administrator workbench (out of context of Library).

On the other hand, templates are not related to any entity. They are used to
speed up the creation process of Documents by initializing their contents.

The Documents/templates browser is made of the following specific tabs:

* Source, which presents the content of the Document/template in a Visual
XML format,

* Properties (not available for templates), which contains data on the
Document output format.

Particular case: Services Modeler entities
The "Documentation’ tab allows you to associate with each of the entities
which compose a Service (Service, Operation, Message, Part and Soap binding
entities), with a documentation of the following types: technical-, functional-
and user-type documentation.

Text editors are available to you in sub-tabs.

These editors, however similar in presentation, are independent, one for each
type of documentation.

Because of this same graphic presentation, it is important, to understand fully
its added value, to respect through its contents, the use primarily reserved for

each of this documentation type.

This reserved use is proposed to you in the online help of each
"Documentation” sub-tab ("Technical’, ‘Functional” and "User”).

In each of the text editors opened from these sub-tabs, you type your text in
word wrap mode.

The only formatting function available is the paragraph (RETURN key).

This format is restored at generation to produce a documentation which can
be read easily.

Technical documentation

This documentation is reserved for the architect of the Service.
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It describes the architecture of the Service, i.e. the technical choices, the
management rules, the limitations, ...

It is thus important that this documentation be available at any time, both at
implementation and maintenance stages.

Once typed in the text editor, this documentation is generated via the
publishing function and then stored in and readable from the AD workbench.

Functional documentation

The functional documentation is reserved both for the architect and for the
user of the Service.

It provides a functional description of the Service, of its Operations, of the
structure of the Messages (input/output) as well as the Binding.

Once typed in the text editor, this documentation is generated in the WSDL
file, framed by "functional documentation” tags.

User documentation

This documentation is reserved for the end-user who wishes to access the
Service.

It provides a clear description, easy to understand of each of the entities that
compose a Service.

Once typed in the text editor, this documentation is generated in the WSDL
file, framed by "user documentation’ tags.
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Chapter 11. Generation

the "Window’” menu.

Generation manager.

£II|I

To create a new generation request, click the ™

To generate one or more instances, select the ‘Generation Manager’ choice in

o1
First select your request in a drop-down list which contains all generations

con in the tool bar of the
associated with the current module, then enter the instance to generate. You
may also enter other characteristics specific to the request:

75



76

Smart Guide ]
Create a Generation Request
Generation Reguest Generation option
|Faolder (GMF) R
CHLOGICIELSS
Likrary

@] TLO Gestion des Lots.

Optional Command Lines Set/ BEFORE [
Optional Command Lines Set/AFTER [

FParameters

=

Farameter ¥alue

000 | | N = |0 b | —

What do vou want to dowhen finished 7
i+ Return

" Qpen the browser

" Do another creation

Finish Cancel

The Generation manager is a two-tab browser:

* The 'Generation Request’ tab displays, in the left pane, the list of
generation requests. If an instance is selected, its characteristics are
displayed in the right pane.
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* The other tab is subdivided into two parts which initially display, if any,
the user’s command line set. These lines are created by an Administrator in
the User browser.

You (‘user’) may modify these lines or create new ones to satisfy your own
specific needs.

To start the generation, select the listed request(s) (in the check box on the

left), and click the ‘;? icon.

For a detailed documentation about this browser, consult the online help.
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Chapter 12. Preferences

You can customize the general look and feel of Administrator & Developer
workbench.

Before working in AD workbench, it is advised to verify the default options,

and -- if needed -- modify them. As if some preferences have a limited impact,
such as preferences related to your workbench graphic appearance, other have
an important functional role.

To customize your workbench, use the 'Preferences’ choice in the ‘File’ menu.

The dialog box that appears has a tree-like structure whose branches vary

according to the module being used.

N
B Preferences

E..

=

~_ 4 General

=4 Appearance
w b Fonts
------ # Toolhars

_'Workspace

------ # Off Line

------ # External controls

------ # Cross references search
------ # Override Mode

~_ 4 Btructured Language

=4 Source

i@ Operatars

e COBOL Keywards
------ ® Warking Area
------ # Beginhing insetions

-4 Report
- @ Dialog Preferences
~_4 eBusiness Tools

4 pBUsiness Generator
@ eBusiness Services Test Facility

-4 Puhlighing

Set general preferences

General

Pane Behavior
v Show title bars

v Highlight selectad pane

Pane History Cache Size

Ok

Cancel

X
b

o

Help

Preferences may be generic or specific to the used module. In the example
below, the eBusiness Tools preferences are available in the eBusiness and
Global workbench modules only.
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However, all preferences are saved for a given module. If you use several
modules, the generic preferences modifications are not automatically carried
over from a module to another one. For a detailed documentation about
preferences, use the [Help] button.
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